Introduction

Inevitably, the first time you sit down in front of any new computing tool, the question arises: "Now what do I do?" Well, if that's how you felt the first time you looked at the 1010data® Trillion-Row Spreadsheet® interface, you've come to the right place. After all, you're dealing with data. A lot of data. And you can see all of it. Most people have never had that experience. Count yourself lucky. With this Getting Started Guide, you'll learn all the basics that will help you understand how 1010data works and why it's different from other database solutions.

This guide is a collection of tutorials that will help you quickly come up to speed with the core functionality of 1010data. As such, the Getting Started Guide is not comprehensive. For additional information not covered in this guide, refer to the 1010data User's Guide available from the 1010data Documentation Center.
Explore the 1010data Trillion-Row Spreadsheet

The 1010data Trillion-Row Spreadsheet is a graphical user interface (GUI) that allows you to visually interact with your data. Explore the GUI to learn how to use some of the most common user interface elements in 1010data.

1010data gives you several options to interact with the system and analyze your data, but when you first get started, you are likely going to spend most of your time in the Trillion-Row Spreadsheet. The 1010data GUI is a browser-based interface that works similarly to many spreadsheet applications, such as Microsoft® Excel®. The interface uses many elements you may already be familiar with, such as folders, navigation icons, and menus.

Throughout this tutorial, the Sales Item Detail table (pub.demo.retail.item) is used to introduce you to the major elements in the 1010data GUI.

To explore the 1010data Trillion-Row Spreadsheet:

1. Access the 1010data Login page by doing one of the following:
   - From the 1010data home page, click Client Login at the upper right side of the page.
   - In your Internet browser address bar, enter https://www.1010data.com/main/login and press Enter.

   The 1010data Login page appears.

2. Enter your 1010data Username and Password, then click Login.
   Logging in may take several minutes.

   **Note:** If you cannot remember your password, you can reset it. Click Forgot your password? and follow the instructions on the Password Reset page.
The 1010data GUI appears.

A. Folders and Tables

The folders and tables visible to you are displayed in the collapsible Folders and Tables browser on the left side of the screen. Within the Folders and Tables browser, you can open tables, which are organized in folders.

A table is the permanent, unchanging version of the data that is saved on the server. When you open a table in the spreadsheet interface and perform an action or query, it becomes a worksheet. A worksheet is a working copy of the table. In worksheets, you can work with and manipulate your data. You can save the worksheet permanently as a table. You can also save your data analysis as a Quick Query, which can be applied to the original table at any time.

B. Search

The search field in the Folders and Tables toolbar allows you to search for tables. If you know the name of a table you want to open, you can open it directly from the search field.

C. Fold/Unfold

To hide the Folders and Tables browser, click the Fold icon at the upper-right side of the browser pane. Click the Unfold icon to expand the Folders and Tables browser when it is hidden.

D. Recent Worksheets

Your recent worksheets are displayed as links in the Recent Worksheets section on the Start Page. Click a link in this section to open a worksheet in its most recent state.

The Recent Worksheets section does not contain links the first time you log in.

3. In the Folders and Tables browser, to the left of the Published Data folder, click the Expand icon. The Published Data folder opens, revealing additional folders.

   Note: You can also double-click a folder to open it.

4. Double-click the Demo folder and then double-click the Retail folder. The Retail folder opens, revealing the tables contained in the folder.
In the image above, the red box outlines the Demo folder and its contents. The Retail folder is open. In that folder, you will find a table titled Sales Item Detail.

5. Double-click the Sales Item Detail table.
   The Folders and Tables browser hides, and the Sales Item Detail table opens in a new tab.
This is the basic view of a table in 1010data. At the top of the screen, outlined within the larger red rectangle, are the **Go Back** and **Go Forward** icons. Use these icons to move backward or forward through the steps of your analysis. The path to the table in which you are currently working appears to the right of these icons. You can click any part of the path to open that folder in the **Folders and Tables** browser.

Below the **Go Back** and **Go Forward** icons is the **Tables and Worksheets** menu bar. The table below provides a description of each menu in the menu bar and its available options.

**Table 1: Tables and Worksheets menu bar**

<table>
<thead>
<tr>
<th>Menus</th>
<th>Menu description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>File</strong></td>
<td>Options for opening, closing, and saving common 1010data items such as tables and queries.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Options for how to view your 1010data tables, worksheets, and QuickApps. You can set your preferences here.</td>
</tr>
<tr>
<td><strong>Actions</strong></td>
<td>Options to edit and undo 1010data actions such as row selections and sorts.</td>
</tr>
<tr>
<td><strong>Columns</strong></td>
<td>Options for working with columns. You can go to a specific column, create computed columns, and link other tables and worksheets to your current table here.</td>
</tr>
<tr>
<td><strong>Rows</strong></td>
<td>Options for interacting with rows in your current table. You can go to a specific row, find rows, and select rows here.</td>
</tr>
<tr>
<td><strong>Analysis</strong></td>
<td>Quick access to perform summaries, tabulations, and cross tabulations.</td>
</tr>
</tbody>
</table>
### Menus

<table>
<thead>
<tr>
<th>Menu</th>
<th>Menu description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Download</td>
<td>Download options to save your data locally in a variety of file types such as Excel, CSV, and XML.</td>
</tr>
<tr>
<td>Chart</td>
<td>Options for creating charts based on your data analysis.</td>
</tr>
<tr>
<td>Info</td>
<td>Provides detailed information about the current table.</td>
</tr>
</tbody>
</table>

In the previous image, the smaller red rectangle surrounds the **Sort Ascending** (↑), **Sort Descending** (↓), and **Column Information** (ﬂ) icons. The sort icons are used to sort the table by the data in the selected column. The **Column Information** icon is used to display information about the column.

6. Click the **Sort Descending** icon in the **Cost** column.

1010data sorts the table based on the **Cost** column in descending order.

At this point, the table becomes a worksheet because an action was performed on the table.

**Note:** Sorting is very system-resource intensive. As a best practice, do not sort your table or worksheet until the data is narrowed down to a manageable size. Instead of sorting, first **perform a tabulation** or **select a narrow range of rows**.

7. Click the **Column Information** icon in the **Sales** column.

A window opens and displays information about the **Sales** column.
Clicking the **Column Information** icon at the top of a column provides you with a considerable amount of useful information. You can use it in the analysis of your data, especially when writing Macro Language code. If you find yourself in a position where you need information about a particular column, this is an excellent place to start.

8. Close the window that contains the **Sales** column information. The **Sales Item Detail** worksheet is displayed.
A scroll bar, similar to the one outlined in red in the image above, appears on the right side of the worksheet if the screen cannot accommodate all of the rows. The scroll bar in the 1010data GUI allows you to navigate through the data in your worksheet.

9. If there is a scroll bar on the right side of your worksheet, click the **Scroll to end (보고/display)** icon.

   **Note:** If a scroll bar is not displayed in your worksheet, all available data is already displayed; no additional rows of data exist.

1010data scrolls to display the last row of data in your worksheet.
For the purposes of this tutorial, we created a very small data set to illustrate the concepts in this topic. In this case, you can scroll through the data in just a few seconds. However, your tables may contain billions of rows. As you work with the Trillion-Row Spreadsheet, keep in mind that scrolling may not be the most effective way to get to a particular section of data. For that, a better method is to use the **Select Rows** menu item, which is covered in *Select rows* on page 14.

The following table provides a short description of each icon in the scroll bar.

**Table 2: Scroll bar icons**

<table>
<thead>
<tr>
<th>Scroll icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll to top (↑)</td>
<td>Jumps to the very beginning of the table.</td>
</tr>
<tr>
<td>Back one page (↑)</td>
<td>Moves the visible rows of data in a table up by an entire page. In other words, the first non-visible row in the table becomes the first visible row.</td>
</tr>
<tr>
<td>Back one row (↑)</td>
<td>Moves the visible rows of data in a table up by one row.</td>
</tr>
<tr>
<td>Forward one row (↓)</td>
<td>Moves the visible rows of data in a table down by one row.</td>
</tr>
<tr>
<td>Forward one page (↓)</td>
<td>Moves the visible rows of data in a table down by an entire page. In other words, the first non-visible row in the table becomes the first visible row.</td>
</tr>
<tr>
<td>Scroll to end (↓)</td>
<td>Jumps to the very end of the table.</td>
</tr>
</tbody>
</table>

**Note:** You can go directly to any point in the table by clicking within the darker gray parts of the scroll bar. The top edge of the slide bar moves to the point where you click.

10. Click **Columns > Rearrange Columns**.
1010data displays the **Select and Rearrange Columns** dialog.

The **Available Columns** list shows all the columns contained in your table, whether they are currently displayed in your worksheet or not. The **Displayed Columns** list shows the columns that are currently visible in your worksheet and in the order they are displayed left to right. Using this dialog, you can rearrange and hide columns in your worksheet.

11. To move the **Date** column, complete the following steps:
   a) In the **Available Columns** list, click **Date**.
   b) In the **Displayed Columns** list, click the blank space above **Transaction ID**.
      
      The blank space in the **Displayed Columns** list allows you to move a column before the first column in the list.
   c) Click **Show After**.
      
      The **Date** column moves to the top of the list and is displayed as the first column in the worksheet.

12. To remove the **Cost** column, complete the following:
a) In the **Displayed Columns** list, click **Cost**.

b) Click **Hide**.

The **Cost** column is removed from the **Displayed Columns** list and no longer appears in the worksheet.

13. When you are finished with this tutorial, close the **Sales Item Detail** worksheet by clicking the **Close** icon in the **Sales Item Detail** tab.

Take a little time to familiarize yourself with the basic menus and options in the 1010data Trillion-Row Spreadsheet. Make sure you are comfortable opening a table, and do not be afraid to customize the table by rearranging columns so that they are in an order that is useful to you. This will make the next few tutorials much easier, and allow you to focus on the new material presented in them. Before you know it, you will be performing custom analyses on your own data.

For more information about the 1010data GUI, see **User Basics** in the **1010data User's Guide**.
Select rows

Select rows is one of the most basic tasks in 1010data. Use row selection to isolate data that is important to your analysis and create more efficient queries.

Whether you are working with a table that is very small or very large, the first step to answering an analytical question is to narrow down the data you are working with so you see only the pieces of information that apply. While there are many ways to do this, the most basic is a row selection.

The purpose of row selection is to reduce a large collection of general data to a smaller collection of data specific to the question being asked. For example, a question might be "Which store in our chain had the highest sales in December?" Another could be "What were the highest and lowest sales figures for a single transaction?" In both cases, you start with all of your data to answer a question that only requires a subset of that data.

When you work with very large data sets like those typically found in 1010data, the order in which you perform your operations on the data makes a difference in how fast the system can complete those operations. If you make the largest selection that eliminates the most data first, then the subsequent operations you perform finish faster because 1010data does not need to work with as much information. As a best practice, if your data contains columns with date- or time-related information, that is generally the best place to start. However, the largest selection may be something other than date or time information and is based on your data and the analysis you want to perform.

This tutorial explains how to perform a series of row selections to reduce the amount of information in the Sales Item Detail data set.

To perform a row selection:

1. Open the Sales Item Detail table (pub.demo.retail.item).
   
   The name of the Sales Item Detail table is pub.demo.retail.item. The location of the table is provided within the file name. In this case, the table is located in the following folder: Published Data > Demo > Retail.

   1010data displays the Sales Item Detail table. It contains 35 rows of data, of which only a limited number display in the image below.
For the purposes of this tutorial, we developed a smaller data set so you can see the changes being made to the data. Even though performing real analyses require much larger data sets, all the principles in this tutorial apply.

2. Click **Rows > Select Rows**.
1010data displays the **Select Rows** dialog.
When selecting rows in 1010data, you should always make the selection that eliminates the largest amount of data first. This almost always means your first selection should be a date range. For the purposes of this tutorial, limit the data to May 15, 2012 through May 17, 2012.

3. From the drop-down list preceding the first is between label, select Date. In the next field, enter 05/15/12, and in the last field, enter 5/17/2012.

Dates entered must exist in the data set.
Note: A row selection specified using the in between criteria is inclusive, meaning rows with the values entered in the corresponding fields are included in the results.

You may have noticed that different date formats were used in each field. Different formats are valid in 1010data, so you can use the date format that you prefer.

4. Click Select.

1010data displays the results of your selection.
Congratulations, you just performed your first row selection in 1010data! As you can see in the image above, the amount of data in the table is reduced by more than half.

What if you want to see information about a particular store? To do this, again use the Select Rows dialog and enter additional comparison criteria. In this case, you can enter a store number to limit the data to the rows that identify a specific store.

5. In the first row of the Select Rows dialog, do the following:
   a) From the first drop-down list, select Store.
   b) From the second drop-down list, select has the value(s).
   c) In the last field, enter 2.
These selections indicate that you want to see only rows for store 2. If the second comparison option, **does not have the value(s)**, is selected, all of the stores in the table except store 2 display.

If you want to include more than one value (more than a single store in the example above), separate the values with a space.

The example above displays results for both store 1 and store 3. Searching for multiple values is useful when working with information like product numbers.

Now that all of the information you need for your results is entered, you can perform the selection.

6. Click **Select**.  
1010data displays the results of your selection.
In just a few minutes, you narrowed the data down from 35 rows to 5. That is less than one-seventh of the original data. Also, notice that the worksheet indicates the selections you already performed (outlined in red above). This can help prevent duplicating effort when making additional selections.

You can also quickly perform a basic row selection directly from the worksheet by right-clicking any cell and choosing an option that appears in a pop-up menu.

7. Right-click the cell in the first row of the **Date** column. 1010data displays a pop-up menu.

By right-clicking a cell in the worksheet, you can choose from several row selection options that pertain to that cell. Take a look at the available options when you right-click an **Account** cell.

8. Right-click the cell in the first row of the **Account** column. 1010data displays a pop-up menu.
As you can see, when you right-click a cell in the Account column, the options are related to Account and not Date. If you need to perform a simple selection, this is a great way to quickly select rows.

9. When you are finished with this tutorial, close the Sales Item Detail worksheet.

Row selection is an incredibly powerful tool you can use when working with large data sets. Using this simple operation, you can eliminate unnecessary data and focus on what's pertinent. Of course, you can use the advanced selection features to narrow down your results even more, but that is a topic for another tutorial. Feel free to make up a few row selections of your own and try them out on any of the tables in the Published > Demo folder. It will make a big difference as you learn how to work with the 1010data Trillion-Row Spreadsheet, and ultimately, make your analyses faster and more accurate. Good luck!

For more information about selecting rows, see Rows in the 1010data User's Guide.
Create a computed column

A computed column is one of the most useful analytical tools in 1010data. Use a computed column to add a column of information to a worksheet typically using the information from one or more existing columns.

Computed columns are columns you create yourself in many cases using information that is already in the table with which you are working. For example, suppose you have a table that contains all the sales data for a chain of stores. This table has one column called **Sales**, which is the purchase price paid by the customer. It has another column called **Cost**, which is the cost of the item to the retailer. With a computed column, it is easy to create a third column called **Margin** that contains the difference between the sale price and the cost. In this tutorial, you will use the **Sales Item Detail** table to find the margin using a computed column.

To create a computed column:

1. Open the **Sales Item Detail** table (**pub.demo.retail.item**) by completing the following:
   a) In the **Folders and Tables** browser, enter **pub.demo.retail.item** in the toolbar search field.
   
   ![Folders and Tables browser](image)

   b) Click the **Go** icon.

   1010data displays the **Sales Item Detail** table.

   ![Sales Item Detail table](image)

   In this tutorial, the **Sales** and **Cost** columns, outlined above, are used to create the **Margin** computed column.

2. Click **Columns > Create Computed Column**.
1010data displays the **Create Computed Column** dialog.
3. Complete the following fields in the Create Computed Column dialog:

**Column Name** Enter margin.

This is the name 1010data uses to interact with the column. It is also used when writing more advanced value expressions and queries. The column name may only contain alphanumeric characters or underscores and must begin with an alphabetic character (e.g., percent_total_sales). It may not contain any spaces or other special characters.

This is a required field.

**Column Heading** Enter Margin.

This is the label of the column that displays by default at the top of a column in the user interface. The column heading may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. If you want to have a multi-line column heading, use the backtick character (') to separate the lines (e.g., "Percentage of Total Sales (%)").

While not required, this field is recommended.

**Value Expression** Enter sales-cost.

In 1010data, a value expression is a calculation you create to help you analyze your data. In this case, the value in the cost column is subtracted from the value in the sales column.
You can write a value expression that performs either simple or advanced calculations.

This is a required field.

**Display Format**

Select **Number: 1,234,567.89**.

This drop-down list instructs 1010data how to display the new number in the computed column. For example, as a date, a number, as text, and so forth.

This field is not required and can usually be left as the default value.

**Column Width**

Select **5**.

This drop-down list determines how many place values to hold in the column. In other words, the width of the column by the number of characters.

This field is not required and can usually be left as the default value.

**Decimal Places**

Select **2**.

This drop-down list sets how many numbers are displayed after the decimal point.

In this tutorial, dollar amounts are used. Therefore, two decimal places are usually the appropriate setting. However, as you explore 1010data and computed columns, you may find that there are situations where you need more or none at all.

This field is not required and can usually be left as the default value.

You might be asking yourself, "What is actually happening here?" To put it simply, what you just entered above indicates you are creating a new computed column named **margin**. The **margin** column is the value of the **sales** column minus the value of the **cost** column.
You might have noticed the small table at the bottom of the Create Computed Column dialog. This table is helpful in finding the name for the columns in this table. It is important to remember when writing a value expression to always use the column name, not the column heading.

4. Click Submit.
1010data creates the Margin computed column.
5. When you are finished with this tutorial, close the **Sales Item Detail** worksheet.

You just created a new column in the worksheet with a very small amount of effort. The values in each row are calculated by the equation you entered as the value expression, and you can now easily see the margin for every item sold in the entire worksheet. Of course, computed columns are much more powerful than merely subtracting or adding one column from another. With a little practice, you will be able to build columns based on more complicated equations, such as standard deviations and Sharpe ratios.

To learn more about computed columns and value expressions, see **Computed Columns** in the 1010data User's Guide.
**Perform a tabulation**

A tabulation summarizes large amounts of data into a small, easy-to-read table. Perform a tabulation to group the values in a column based on the values in another column.

A tabulation is a great place to start when you want to get a feel for what all those billions of rows of data in your table really mean. Tabulations allow you to calculate various metrics, such as the sum, average, or highest value of a particular column, grouping those calculations based on common values in one or more other columns. For instance, in a table containing weather data, you could calculate the highest temperature during the year for every unique combination of ZIP Code™ and month in the table.

In this tutorial, you will perform a tabulation on the **Sales Item Detail** table to find the total amount of sales for each of three stores in a chain. You will then perform a separate tabulation to find the total amount of sales and units for each transaction. Finally, you will export the tabulation to Excel.

To perform a tabulation:

1. Open the **Sales Item Detail** table (pub.demo.retail.item).
   1010 data displays the **Sales Item Detail** table.

2. Click **Analysis > Tabulation**.
The Tabulation dialog allows you to create a basic tabulation. By default, columns in the resultant worksheet are named \( t_0, t_1, t_2 \), and so on. You can give tabulated columns more meaningful names by using a different view within the Tabulation dialog.

3. Click the Show all inputs sequentially ( ) icon.

1010data displays fields for naming and formatting the columns of the new tabulation.
4. In the **Title** field, enter **Sales by Store**.

   While not required, entering a title is a good way to remind yourself what information is in a tabulation after it is saved.

Next, choose the column by which you want to group the information. In other words, how do you want to subtotal the data. When performing a tabulation, a helpful question to ask yourself is "What values do I want to use to group the records?" Since you want to find the total amount of sales for each store, you should group the information by the **Store** column. Grouping is a way of pooling all the records for a single entity or value (in this case, a store) into a single entry in the table.

5. Group your tabulation by store.
   
   a) In the first row of the **Column** drop-down list, select **Store**.
      
      This selection groups the tabulation by store. The result of the calculation for each store will be displayed on a separate row in the new worksheet.
   
   b) In the first row of the **Sort** drop-down list, select **Up**.
      
      This selection sorts the new worksheet in ascending order by the **Store** column.

Now that the data grouping is set, choose the data you want to summarize.

6. Summarize the total sales for each store.

   Under the **Which columns' data would you like to summarize?** section, complete the following:

   **Column**  
   Select **Sales**.

   This selection chooses the column of data you want to act on. In this instance, you want to calculate the total sales.

   **Type of Summary**  
   Select **Sum**.
This selection chooses the action you want to perform on the selected column. In this case, you want to summarize the data in the sales column.

<table>
<thead>
<tr>
<th>Reference Column</th>
<th>Leave this field blank; it is used for advanced summarization functions, such as weighted averages and correlations. For more information, see <em>Types of Summarizations for Tabulations</em> in the 1010data User's Guide.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Result Name</td>
<td>Enter <code>sumsales</code>. This is the column name. Remember, 1010data column names must begin with an alphabetic character, may only contain alphanumeric characters or underscores, and may not contain any spaces or other special characters.</td>
</tr>
<tr>
<td>Result Heading</td>
<td>Enter <code>Sum of</code> <code>Sales</code>. This is the column label. For easier readability, column labels may contain any combination of uppercase and lowercase letters, numbers, spaces, and special characters. The backtick (` ) special character is used to break the column label text line into multiple lines. In this case, &quot;Sum of&quot; will be on the first line of the column label and &quot;Sales&quot; will be on the second line.</td>
</tr>
<tr>
<td>Display Format</td>
<td>Select <em>Currency: $1,234.56</em>. Since your totals will be dollar amounts, this option is selected. When currency is selected, 1010data adds the dollar sign and uses two decimal places for each tabulated sales value.</td>
</tr>
<tr>
<td>Column Width</td>
<td>Select <em>Default</em>.</td>
</tr>
<tr>
<td>Decimal Places</td>
<td>Select <em>Default</em>. Because you selected currency above, 1010data will automatically use two decimal places.</td>
</tr>
</tbody>
</table>
Now that you have selected the data you want to group by and the data you want to summarize, generate the tabulation.

7. Click **Submit**.
   1010data displays the results of your tabulation.

    ![Tabulation interface](image)

    **Note:** In the image above, the column heading (**Sum of Sales**) is at the top of the column. If you prefer, you can change this to show the column name instead. For details, see **User Interface Preferences** in the 1010data User's Guide.

Notice that there is a row of data in gray at the top of the worksheet. This row shows the totals for each column of summarized data. The three fictional stores generated $59.85 in sales with store 1 generating $23.19, store 2 generating $16.31, and store 3 generating $20.35. While this tabulation might not seem very useful for a chain of three stores, it becomes much more useful when summarizing chains with hundreds, or even thousands, of stores.
Now, you will take a look at a slightly more complex example of a tabulation. Instead of looking at the total sales per store, you will determine the sales totals for each transaction in the Sales Item Detail table. However, you also want to know at which store any given transaction took place, and also the total number of items in each transaction. The objective is to have a summary table that shows you the transaction ID, store, sum of sales, and total units for each transaction.

8. Click the Go Back (≡) icon in the Tables and Worksheets toolbar.

1010data displays the original Sales Item Detail table. Just as before, in the Tabulation dialog, give your tabulation a title and then start by selecting a column to group your data. In this case, you want to see the total sales figures for each transaction. You also want to know which store recorded each of the transactions in the table, so you should also group by store.

9. In the Title field, enter Sales by Transaction.

10. Group your tabulation by transaction and store.
   a) In the first row of the Column drop-down list, select Transaction ID.
   This selection first groups the tabulation by transaction. The result of the calculation for each transaction will be displayed on a separate row in the new worksheet.
   b) In the first row of the Sort drop-down list, select Up.
   This selection sorts the new worksheet in ascending order by the Transaction ID column.
   c) In the second row of the Column drop-down list, select Store.
   This selection divides the tabulated results into subgroups by store. In this example, the results are first grouped by transaction and then by store.

   **Note:** In most cases, the order by which you choose to group the data is important because it can affect the results of the tabulation.

Now that you have grouped your data, first by transaction, then by store, you can choose the data you want to summarize. In this example, you are still summarizing sales, so you can make the same exact selection you made in the last example.

11. Summarize the total sales for each transaction.

   Under the Which columns’ data would you like to summarize? section, from the first group of fields, complete the following:

   **Column**
   Select Sales.
   This selection chooses the column of data you want to act on. In this instance, you want to calculate the total sales.

   **Type of Summary**
   Select Sum.
   This selection chooses the action you want to perform on the selected column. In this case, you want to summarize the data in the sales column.

   **Reference Column**
   Leave this field blank.

   **Result Name**
   Enter sumsales.

   **Result Heading**
   Enter Sum of `Sales.

   **Display Format**
   Select Currency: $1,234.56.

   **Column Width**
   Select Default.

   **Decimal Places**
   Select Default.
12. Summarize the total items in each transaction.

Under the **Which columns’ data would you like to summarize?** section, from the second group of fields, complete the following:

**Column**

Select **Units**.

This selection is chosen because you want to determine the number of units.

**Type of Summary**

Select **Sum**.

This selection is chosen because you want to see the total number of units in each transaction.

**Reference Column**

Leave this field blank.

**Result Name**

Enter **totunits**.

**Result Heading**

Enter **Total Units**.

**Display Format**

Select **Default**.

**Column Width**

Select **Default**.

**Decimal Places**

Select **Default**.
Now that you have selected the data you want to group by and the data you want to summarize, generate the tabulation.

13. Click **Submit**.

1010data displays the results of your tabulation.
Getting Started Guide | Perform a tabulation | 37

Notice that in the new summary, the total sales figure in the gray row at the top of the worksheet remains the same. However, instead of the total sales by store, 1010data displays the total sales figure for each transaction and the store at which the transaction took place. In addition, the tabulation includes the total number of units sold in every transaction to provide a little more insight into volume. This provides you with an extra layer of detail or granularity in your results. Yet, the new table is still much easier to read and understand than the original Sales Item Detail table.

The final step in this tutorial is to download your results in a Microsoft Excel workbook file.

14. Click **Download > To Microsoft Excel** and select one of the following from the menu:

- **XLSX**
  
  Select this menu item to download the tabulation in a workbook file for Excel 2007 and newer.

- **XLS**
  
  Select this menu item to download the tabulation in a workbook file for Excel 2003 and earlier.

1010data saves the tabulation to your computer as `download.xlsx` or `download.xls`.

**Note:** Depending on the browser you are using, you may be prompted to open or save the file. If you are prompted, save the file.

15. When you are finished with this tutorial, close the Sales Item Detail worksheet.
Once you are comfortable with them, tabulations in 1010data are a very fast and powerful way to get a sense of what information your data contains and how it can be leveraged to make decisions. So with that in mind, good luck and keep practicing.

For more information about tabulations, see *Summarizations and Tabulations* in the *1010data User's Guide*. 
Linking provides a simple yet powerful way of combining the data from two tables. Use linking to combine tables or worksheets into a single, bigger table with columns from both.

When you work a lot with data, you will often find yourself in a position where you want to use two separate tables, which contain different but related data, to answer a question. 1010data has a highly effective feature that allows you join the information from related data tables together in a straightforward manner. It is called linking, and it is one of the things 1010data does best.

The Sales Item Detail table you have been working with in the previous tutorials of this guide contains information about every transaction for your fictitious retail chain. However, what if you wanted to know which department each item in those transactions came from? That information is found in the Product Master table. Similarly, what if you wanted to know more about the store in which that transaction took place? That information is found in the Store Master table. If you could combine those tables with your Sales Item Detail table and match up the data, you would be able to learn exactly what those details are.

In the linking tutorials in this guide, you will start with the Sales Item Detail table.

This table contains a lot of useful information about every transaction in your fictional retail point of sale (POS) system. The Item SKU column provides a reference to the exact product that was purchased. Within this table, you can see the date, store, and sale price of every item that was sold, as well as in which transaction it took place. However, based on the information in this table, you do not know any details about the items other than a SKU code. Fortunately, you have access to a Product Master table that gives a description of these items.
Getting Started Guide | Linking | 40

Note: It is not necessary to open the Product Master table to link it in. Linking in a table can be done without opening the foreign table. It is shown here to illustrate the relationship between the tables in the link operation.

The Product Master table shown above contains specific information about all the product SKUs that are also in the Sales Item Detail table. Here you can see descriptions for each product, its category, and the department of the fictitious retail chain in which it is sold. But what if you wanted to look at this information as it relates to your sales data? The answer is to link the two tables together at a common data point. In this instance, both tables contain item SKU data. In this tutorial, you will use the SKU column in both tables to link them together.

Note: If you come to 1010data with an SQL background, you can think of linking tables as equivalent to a join in SQL.

For more information about linking, see Linking Tables and Worksheets in the 1010data User’s Guide.

**Link in a table**

You can link in another 1010data table to the current table or worksheet.

In this tutorial, you will link the Product Master table into the Sales Item Detail table. The combination of these two tables provides you with both the product and sales information within one worksheet for items sold within your fictitious retail chain.

To link in a table:

1. Open the Sales Item Detail table (pub.demo.retail.item).
   1010data displays the Sales Item Detail table.
2. Click **Columns > Link in Another Table**.

   1010data displays the **Link in Another Table** dialog.

   ![Link in Another Table dialog](image)

   This dialog is used to select the foreign table (**Product Master**) you want to link into the current table (**Sales Item Detail**). By default, the dialog displays the current folder, which is where the **Product Master** table is located.

3. Under the **Select table** section, click the **Product Master** table link.

   1010data displays the **Select columns** section in the dialog.
In the Select columns section, you select at least one column in the foreign table (Product Master) that matches a column from the base table (Sales Item Detail). For example, an item in the Sales Item Detail table that has a value of 366 in the Item SKU column matches with the first row in the Product Master table that has a value of 366 in the SKU column. These columns provide a common data point where the two tables can be linked. While you can link two tables with more than one column at the same time, this tutorial focuses on linking a single column.

**Note:** When linking two tables, make sure that the columns from each table have the same data type. For example, an error will occur if you attempt to link a column with integer values in one table to a column with text (or string) values in the other. See Linking Columns with Different Types in the 1010data User's Guide for more information.

4. Select Item SKU from the first drop-down list.

   This is the column from the Sales Item Detail table you currently have open.

   **Note:** It is important to point out that the items in each drop-down list are the column headings from the table, not the column names.

   Next, select a column in the foreign table you are linking in that corresponds to the one you just selected in the table you currently have open.

5. In the first drop-down list under the Corresponding Column(s) section, select SKU.

   This is the column in the Product Master table you are linking in. Again, this is the heading of the column, not the name.

6. In the Suffix field, enter _pm.

   While not required, this field is highly recommended as it differentiates the column names from the two tables you are linking. By adding the _pm suffix to the columns from the Product Master table, it will be clear in the final worksheet which columns came from the Sales Item Detail table and which came from the Product Master table.
7. Click **Submit**.

1010data links the **Product Master** table into the **Sales Item Detail** table and displays the columns from the two tables combined.

With the columns combined, not only can you see that an item with the SKU 3B7 was purchased on 5/15/12 at store 1, but you can also see its corresponding item description (**PEPSI 20 OZ**) and department (**SNACKS**).

8. Click the **Column Information** (.icon) in the **Item Description** column.

A window opens and displays information about the **Item Description** column.
Notice in the Name field that the _pm suffix that you specified is added to the end of the column name. This indicates that the column is a linked column from the Product Master table.

Note: If you prefer, you can change your preferences to show the column name instead of the column label in the worksheet. For details, see User Interface Preferences in the 1010data User's Guide.

9. When you are finished with this tutorial, close the Sales Item Detail worksheet.

In this tutorial, you linked the Product Master table, which had not been changed in any way, into the Sales Item Detail table. However, what if you had done some work to the Product Master table, thus making it a worksheet? Depending on exactly what you want to do with this worksheet, there are two additional linking options: Link in Another Worksheet and Link and Select Rows. These options are covered in these two tutorials:

- Link in a worksheet on page 44
- Link and select rows on page 49

**Link in a worksheet**

Linking in a worksheet allows you to perform various actions on a table and then link the results into an existing table or worksheet.

What if you wanted to modify the Product Master table and link those results into the Sales Item Detail table? You might do this because you only want to link in additional information for a subset of the data. For example, in this tutorial you only want to link in the additional product information for items in the snacks department. You can accomplish this by selecting the rows corresponding to that department in the Product Master table and then using the Link in Another Worksheet option to add the data to the Sales Item Detail table. In this example, you are working with only 35 rows of data. However, for tables with billions of rows, linking in only the additional information you need is more efficient and can result in quicker processing.
To link in a worksheet:

1. **Open the Product Master table (pub.demo.retail.prod).**
   1010data opens the Product Master table.

   The **Product Master** table contains products from a number of departments. Perhaps you only want to see the results for department 22. Start by selecting only the rows from that department.

2. **In the Department column, right-click any of the instances of the value 22 and choose Select rows where Department has the value 22 from the menu.**
   Because the original **Product Master** table has been modified by the row selection, it is now considered a worksheet. The worksheet has four rows.

   This worksheet can now be linked into your **Sales Item Detail** table in its current form.

3. **Open the Sales Item Detail table (pub.demo.retail.item).**
   1010data displays the **Sales Item Detail** table.
4. Click **Columns > Link in Another Worksheet**.

1010data displays the **Link in Another Worksheet** dialog.

This dialog lists any worksheets you currently have open. In this case, you want to link in the **Product Master** worksheet that you just modified.

5. Under the **Select worksheet** section, click the **Product Master** link.

1010data displays the **Select columns** section in the dialog.
Just like when you linked in the original Product Master table in Link in a table on page 40, link once more on the SKU columns and provide the _pm suffix.

6. Select Item SKU from the first drop-down list.
7. In the first drop-down list under the Corresponding Column(s) section, select SKU.
8. In the Suffix field, enter _pm.
9. Click **Submit**.

1010data links the **Product Master** worksheet into the **Sales Item Detail** table.

The result is a new worksheet that has information from the **Product Master** worksheet only for those item SKUs that fall under department 22. However, the other rows in the **Sales Item Detail** table remain, and the columns from the **Product Master** worksheet are left blank for items not in department 22. This is useful if you want to look at additional information about one subset of rows in a table or worksheet but still maintain the original level of detail for the other rows.
10. When you are finished with this tutorial, close both the **Product Master** and the **Sales Item Detail** worksheets.

In this tutorial, you learned how to link in a worksheet. Again, notice that only the rows that applied to the selection in the foreign worksheet now have the columns linked from the foreign worksheet. However, what if you want to simply eliminate the rows that are not applicable to the selection in the foreign worksheet? In that situation, you would perform a very similar operation called **Link and Select Rows**. To learn how, see *Link and select rows* on page 49.

---

**Link and select rows**

By performing a link and select, you can include only those rows that have corresponding matches in the foreign table or worksheet, thereby eliminating the need to do a subsequent row selection after the link.

The process to link and select rows is nearly identical to the process of simply linking to another *table* or *worksheet*. The only difference is the results produced. Instead of applying the information from the foreign worksheet to the entire base table or worksheet, **Link and Select Rows** retains only those rows in the base table that correspond to the selection in the foreign table.

For instance, what if in the *Link in a worksheet* on page 44 tutorial, you only wanted to see SKUs in the base worksheet that are in department 22? Since department information does not exist in the base table, you cannot make that selection. You could first link in the *Product Master* as the foreign table and then perform a row selection. However, that requires first linking in more rows than you need, which is less efficient. The best solution is to first select the rows in the *Product Master* table, then perform a link and select to eliminate the rows in the base table that cannot be linked.

To link and select rows:

1. Open the **Product Master** table *(pub.demo.retail.prod)*. 1010data opens the **Product Master** table.

   ![Product Master Table](image)

As in *Link in a worksheet* on page 44, start by selecting only the rows from department 22.

2. In the **Department** column, right-click any of the instances of the value 22 and choose **Select rows where Department has the value 22** from the menu.

   Because the original **Product Master** table has been modified by the row selection, it is now considered a worksheet. The worksheet has four rows.
The link and select rows operation can now be used to link the worksheet into your Sales Item Detail table in its current form.

3. Open the Sales Item Detail table (pub.demo.retail.item).
   1010data displays the Sales Item Detail table.

4. Click Columns > Link and Select Rows.
   1010data displays the Link and Select Rows dialog.
This dialog is almost identical to the Link in Another Worksheet dialog, except that you are given the option to link in another table (one that had not been modified) or a currently open worksheet. In this tutorial, you want to use the open Product Master worksheet, in which rows containing department 22 are selected.

5. Under the Worksheet section, click the Product Master link. 1010data displays the Select columns section in the dialog.
Just like when you linked in the original **Product Master** table in *Link in a table* on page 40, link once more on the SKU columns and provide the _pm suffix.

6. Select Item SKU from the first drop-down list.
7. In the first drop-down list under the Corresponding Column(s) section, select SKU.
8. In the Suffix field, enter _pm.

9. Click **Submit**.
   1010data links the **Product Master** worksheet into the **Sales Item Detail** table.

The result is a new worksheet with only the rows from the **Sales Item Detail** table that have SKUs in department 22, reflecting the selection from the **Product Master** worksheet. Only rows left in the **Sales**
Item Detail worksheet are those that apply to the initial selection you made in the Product Master worksheet. This method allows you to use links more efficiently and effectively in your analyses.

10. When you are finished with this tutorial, close both the Product Master and the Sales Item Detail worksheets.

The linking tutorials are intended to introduce you to the topic of linking, but it is a complex topic with many variations, which makes it very powerful. Finding ways to combine data sets and provide them with context is what 1010data is all about. After reviewing these tutorials, take some time to explore tables and see if they have places where they can be joined by columns with similar information. This will help you understand how your data is interrelated, and start you down the path of deeper, more insightful analysis.
Cross tabulations

A cross tabulation allows you to summarize the values in a column based on the values in two or more other columns and display the result as a matrix.

In the tutorials in this section, you will learn how to perform a cross tabulation. Once you have performed a cross tabulation, you will learn how to create a computed column from your cross tabulation.

A cross tabulation can help you gain granularity from a summary without losing the highest level of data summarization. For example, in addition to finding the total amount of sales for each store in your chain, you can also obtain the sales figures for the individual departments within each store and how they compare to the total.

To illustrate this concept, shown below is the Sales by Store summary from Perform a tabulation on page 29.

This result was reached simply by adding up the total sales for each store and assigning the total for each result to a single row in the table. Another way to think about this is that you created a “bucket” for each store and placed the amount of each transaction in the bucket of the store where the transaction took place. What if you want to know which departments contributed to the sales of each store?

The best way to get this information, without losing sales totals for each store, is to perform a cross tabulation. Effectively, a cross tabulation groups on a second metric and summarizes it, placing the data into one column for each unique value in the group. Each row will contain sales figures for each store, and a new set of columns will be created to show the sales totals for each department.

For additional information about cross tabulations, see Summarizations and Tabulations in the 1010data User's Guide.

Perform a cross tabulation

A cross tabulation provides extra granularity from a summary without losing the highest level of data summarization.

In this tutorial, you will learn how to perform a cross tabulation to determine the sales amount by store. The sales totals for each store will be broken out by department so you can see how much each department contributed to the total sales.

To perform a cross tabulation:

1. Open the Sales Item Detail table (pub.demo.retail.item).
   1010data displays the Sales Item Detail table.
To get the department information for your cross tabulation, you need to link in the Product Master table. This is identical to the process used in Link in a table on page 40.

2. Click Columns > Link in Another Table.
   1010data displays the Link in Another Table dialog.

3. Under the Select table section, click the Product Master table link.
   1010data displays the Select columns section in the dialog.

4. Select Item SKU from the first drop-down list.

5. In the first drop-down list under the Corresponding Column(s) section, select SKU.

6. In the Suffix field, enter _pm.

7. Click Submit.
   1010data links the Product Master table into the Sales Item Detail table and displays the results of the link.
8. Click Analysis > Cross Tabulation.  
1010data displays the Cross Tabulation dialog.

9. Enter Sales by Store by Department in the Title field.  
10. Under the What values do you want to use to group the records? section, complete the following:
   a) In the first drop-down list under Rows of Result, select Store.  
      This selection creates a row for each store in the cross tabulation.
   b) In the first drop-down list under Columns of Result, select Department Description.  
      This selection creates a column for each department in the cross tabulation. The Department Description will be parsed for its individual values and then summarized. In this case, a column for each department that had sales will be created.
Next, you need to select the actual summary type. The summary applies to both the row grouping and the column grouping. In this case, we are calculating total sales by department for each store.

11. Under the **Which summary data would you like to see?** section, complete the following:

**Column**  
Select **Sales**.

This selection chooses the column of data you want to act on. In this instance, you want to calculate the total sales.

**Type of Summary**  
Select **Sum**.

This selection chooses the action you want to perform on the selected column. In this case, you want to summarize the data in the sales column.

**Reference Column**  
Leave this field blank.

**Display Format**  
Select **Currency: $1,234.56**.

**Column Width**  
Select **Default**.

**Decimal Places**  
Select **Default**.

12. Click **Submit**.

1010data displays the results of your cross tabulation.
As you can see above, the totals for all the stores are still available in the first column outlined in red. However, you can also see how much each department contributed to those totals. For instance, the Snacks department accounted for $24.30 of the $59.85 in total sales across all the stores in our fictional retail chain.

Further granularity shows that in store 1, $12.30 was from the Snacks department.

13. When you are finished with this tutorial, close the Sales Item Detail worksheet.

Cross tabulations are a great way to get further insight into the numbers of regular tabulations. You can keep your totals, but see the story behind the numbers by breaking them down into their constituent parts. Next time you are not sure about why a summary looks the way it does, rely on a cross tabulation to better understand your data and your business.

Create a computed column from a cross-tabulated column

Once you have a completed cross tabulation, you can work with the resultant columns of the new worksheet the same as you would with any other 1010data table. This makes it easy to create new metrics based on your summaries.

In this tutorial, you will perform a simple day-over-day calculation by first creating a cross tabulation and then creating a computed column.

In your analysis, you want to see the sales of one date compared to the sales of a different date for all three of your fictional stores. For this example, the dates are consecutive.

To create a computed column from a cross-tabulated column:

1. Open the Sales Item Detail table (pub.demo.retail.item).
   1010data displays the Sales Item Detail table.
Next, perform a row selection to get the two days in which you are interested.

2. Click **Rows > Select Rows**.  
   1010data displays the **Select Rows** dialog.

3. From the drop-down list preceding the first **is between** label, select **Date**. In the next field, enter **20120517**, and in the last field, enter **20120518**.
4. Click Select.
1010data displays the results of your selection.

Next, you will create your cross tabulation. This will give you the totals for both the stores overall, and the totals for each of the two dates you selected.

5. Click Analysis > Cross Tabulation.
1010data displays the Cross Tabulation dialog.
6. Enter **Sales by Store by Date** in the **Title** field.

7. Under the **What values do you want to use to group the records?** section, complete the following:
   a) In the first drop-down list under **Rows of Result**, select **Store**.
      This selection creates a row for each store in the cross tabulation.
   b) In the first drop-down list under **Sort**, select **Up**.
      This selection sorts the new rows in ascending order by store number.
   c) In the first drop-down list under **Columns of Result**, select **Date**.
      This selection creates a column for each date for which the store had sales.

Next, you need to select the summary type. The summary applies to both the row grouping and the column grouping. In this case, we are calculating total sales by date for each store.

8. Under the **Which summary data would you like to see?** section, complete the following:

   - **Column**: Select **Sales**.
     This selection chooses the column of data you want to act on. In this instance, you want to calculate the total sales.

   - **Type of Summary**: Select **Sum**.
     This selection chooses the action you want to perform on the selected column. In this case, you want to summarize the data in the sales column.

   - **Reference Column**: Leave this field blank.

   - **Display Format**: Select **Currency: $1,234.56**.

   - **Column Width**: Select **Default**.

   - **Decimal Places**: Select **Default**.
Here, your horizontal (row) summary is grouped by store, and the vertical (column) summary is grouped by date.

9. **Click Submit.**
   1010data displays the results of your cross tabulation.

   ![Sales by Store by Date](image1)

   Since you eliminated all the dates except the two you are interested in, you can now create a computed column that shows the difference in sales from one day to the next.

10. **Click Column > Create Computed Column.**
    1010data displays the **Create Computed Column** dialog.
11. Complete the following fields in the **Create Computed Column** dialog.

- **Column Name**: Enter `dod`.
- **Column Heading**: Enter `Day-Over-Day`.
- **Value Expression**: Enter `m1-m0`.
  
  **Note**: By default, resultant columns in cross tabulations are named `m0`, `m1`, etc.

  In this case, to calculate the day-over-day sales, simply subtract the values in the column with the less recent date (`m0`) from the values in the column with the more recent date (`m1`).

- **Display Format**: Select **Currency**: $1,234.56.
- **Column Width**: Select **Default**.
- **Decimal Places**: Select **Default**.
12. Click Submit.
   1010data creates the **Day-Over-Day** computed column.

From the results, it is clear that the sales for store 2 plummeted on the last day.

13. When you are finished with this tutorial, close the **Sales Item Detail** worksheet.

Cross tabulations are a great way to get further insight into the numbers of regular tabulations. You can keep your totals but see the story behind the numbers by breaking them down into their constituent parts. Next time you’re not sure about why a summary looks the way it does, rely on cross tabulations to better understand your data and your business.
Quick Queries

Quick Queries can be used to save your work so that you can re-use it later or share it with your colleagues at a later time.

In the tutorials in this section, you will learn how to create and save a Quick Query. Quick Queries can be used to save a set of actions so that they may be rerun at a later time. Once you have created a Quick Query, you will learn the different actions you can perform on a saved Quick Query such as editing it or adding it as a favorite. Finally, you will learn how to share a Quick Query and folders with others in your organization.

For additional information about Quick Queries, see Quick Queries in the 1010data User's Guide.

Save a Quick Query

A Quick Query is a saved query that can be reused. When saving a Quick Query, you can save it exactly as it is, or you can parameterize it for added flexibility and usefulness.

At some point, you may find yourself running the same query over and over. Rather than rebuilding the query from scratch each time you want to run it, you can save it as a Quick Query. A Quick Query can run on tables that change over time without needing to change the query itself. In addition, you can parameterize the query so that when it is run, the Quick Query will prompt you for values that you provide. For example, rather than always obtaining sales data for one particular store, you could specify any store in the chain.

In this tutorial, you start by building a query to find all of the transactions for store 1. Then, you save the query and parameterize it so that when it is run, you can obtain sales data for any store in the chain. The query will be saved in a folder that you specify. In this tutorial, the location and name of an example user folder is provided for illustrative purposes. As you follow this tutorial, you will use the location and name of a user folder that you have permission to write to.

**Note:** In order to follow this tutorial, you need to have a user folder that you have permission to write to. If you do not, contact your 1010data administrator to have one created.

To save a Quick Query:

1. Open the Sales Item Detail table (pub.demo.retail.item).
   
   1010data displays the Sales Item Detail table.
2. Click **Rows > Select Rows.**
1010data displays the Select Rows dialog.
Use the dialog to select rows in the table associated with store 1.

3. Select **Store** from the first drop-down list, **has the value(s)** from the second drop-down list, and enter 1 into the text field on the right.
4. Click **Select**.
   1010data displays the results of your selection.
Your worksheet contains the 17 rows from the **Sales Item Detail** table that are from store 1.

**Note:** At this point, you could save the results as a permanent table. This is helpful if you want to archive the information or if you need this particular table in the future and know the information in it will never change. However, in most cases it makes more sense to save the query instead of a static table. That way, if new data is added to the table, all you need to do is rerun the query. In addition, saving a table takes up disk space. When you work with tables that contain millions or billions of rows, that can add up quickly. The only way to know when you have exceeded your limit is when you receive an error message.

Instead of saving the table, save the current query as a Quick Query with the store value as a parameter, so that you can specify any store (not just store 1) when it is run.

5. Click **File > Save as Quick Query**.

![Save as Quick Query dialog](image)

1010data displays the **Save As a Quick Query** dialog.
Under **Save into folder**, browse to the location where you want to save the Quick Query. You can save your Quick Query in folders labeled with **Add** or **Own** after the folder name. These labels correspond to the **Uploader (♂)** and **Owner (♀)** icons, respectively, in the **Folders and Tables** browser.

**Note:** Although you can save a Quick Query in your **My Data** folder, 1010data recommends that you save your Quick Queries in your user folder or one of its subfolders. This is especially important if you want to share access to the Quick Query with other users or user groups. You cannot create subfolders in your **My Data** folder, which means you would need to give permission to each user for every item in your **My Data** folder you want to share (in the case of this tutorial, your Quick Query). Another way to share objects in 1010data is explained later in **Share a Quick Query** on page 79.

6. Click the **All Databases** folder and then navigate to the location of the user folder where you want to save the Quick Query.

![](image)

**Note:** In the image above, the owned user folder, **Examples**, is used to illustrate this concept. Your folder name and location will be different.

Next, give your Quick Query a descriptive name so that you and others know what it does.

7. Enter **Transactions by Store** in the **Title of Query** field.

![](image)

Under the section labeled **Query Choices**, specify which items will require input when a user runs your Quick Query. In this tutorial, you want the user to be able to enter any value for the store number, not just 1.

8. In the row of the table associated with the **Value for criterion 1** parameter, select the checkbox in the **Input?** column.
   
   This indicates that you want the user to enter a value for the store number (criterion 1) when the Quick Query is run.

9. In the row of the table associated with the **Value for criterion 1** parameter, enter the phrase **Enter store number** in the **User Prompt** column.
   
   When the Quick Query is run, this text is displayed so the user knows what information is needed.
10. Click **Submit**.

1010data displays a message indicating that your Quick Query was saved in the selected folder. Your saved Quick Query can be reused at any time to select sales information based on the store you enter at the time it is run.

Now that you have learned how to create and save a Quick Query, see *Edit a Quick Query* on page 72. This tutorial explains how to perform actions such as running and editing your Quick Query.

### Edit a Quick Query

You can perform certain tasks on an existing Quick Query. For example, you can view and edit details of a Quick Query, run it, and add it as a favorite.

This tutorial introduces you to some of the tasks you can perform with the Quick Query you saved in *Save a Quick Query* on page 65.

To take this tutorial, you must have completed the *Save a Quick Query* on page 65 tutorial.

To edit a Quick Query:

1. In the **Folders and Tables** browser, navigate to the folder where you saved your Quick Query. 1010data displays your saved Quick Query.
2. Double-click the **Transactions by Store** Quick Query to run it.
1010data runs the **Transactions by Store** Quick Query and prompts you to enter a store number.

The value that you specified in the original query for the store number is listed with the descriptive prompt you specified.

Next, find out what transactions were from store 3.

3. Enter 3 in the **Enter store number** field and then click **Submit**.

   **Note:** You can run the Quick Query for more than one store by entering a space-separated list of store numbers.

1010data displays the results of your Quick Query.
As you can see, 1010data ran the query and presented only the sales information for store 3.

4. Click the Unfold (►) icon.
1010data displays the Folders and Tables browser.

5. Select the Transactions by Store Quick Query by single-clicking it.
1010data highlights the Quick Query in blue and displays the full path below the Folders and Tables toolbar. In addition, a list of actions you can perform are displayed.

6. In the list of actions below the Folders and Tables toolbar, click View Info.
1010data displays detailed information about the selected Quick Query.

Detailed information about the Quick Query includes the title, which you set when you created the Quick Query; the name and full path to the Quick Query; the owner; and the users who have permission to
use the Quick Query. The Users field is discussed and used later in Share a Quick Query on page 79. Finally, the References field displays the name of the table this query will be applied to, which in this case is the name of the Sales Item Detail table (pub.demo.retail.item).

7. Click the Close (X) icon.

Next, you will learn how to edit your Quick Query to provide more flexibility. Instead of specifying just one store, you can edit your Quick Query to accept a qualifier when it is run. For instance, you might want to see the transactions for every store except the store you specify.

8. Ensure that the Transactions by Store Quick Query is still selected.

9. In the list of actions below the Folders and Tables toolbar, click Edit Query.

The Save As a Quick Query dialog is presented with all the information for the current query.

The dialog is almost identical to the one you originally completed, but it now has a Replace old query checkbox. If this checkbox is selected, the original query is replaced when you click the Submit button.

Note: Running an existing Quick Query and then clicking Save As Quick Query from the File menu is different from editing an existing Quick Query. If you ran the Quick Query you just created and then clicked Save As Quick Query from the File menu, 1010data displays the Save As a Quick Query dialog.
This dialog is different from the dialog you used to save your original query; there is no criteria listed under **Query Choices** and there is no **Replace old query** checkbox. In essence, this creates a new Quick Query based on the results of running your original Quick Query.

10. **Select the Replace old query checkbox.**

   **Note:** The Replace old query checkbox takes precedence over the Save into folder directory structure below it. If you select the Replace old query checkbox, the query is saved where it currently resides, regardless of what the Save into folder directory structure indicates.

Change the title of the Quick Query to reflect that you may be looking at transactions from more than one store.

11. **Enter Transactions by Store(s) in the Title of Query field.**

12. In the row of the table associated with the Relation for criterion 1 parameter, select the checkbox in the Input? column.

   ![Query Choices Table](image)

   This option allows you to choose a relationship for the input when the Quick Query is run.

13. **Click Submit.**

   1010data saves the changes to your Quick Query and displays a confirmation message.

14. **Return to the Folders and Tables browser and locate your Quick Query.**

   You can see from the changed title that your modified Quick Query replaced the original in your user folder.
Note: To see the changes, you may need to close the folder containing the Quick Query by clicking the Collapse (▼) icon to the left of the folder and then reopen it by clicking the Expand (►) icon.

15. Double-click the Transactions by Store(s) Quick Query to run it. 1010data runs the updated Transactions by Store(s) Quick Query.

The updated Quick Query prompts you to select a relationship in addition to a store number. Provide the criteria to your Quick Query to find the transactions for every store except store 1.

16. Select does not have the value(s) from the Choose a relationship drop-down list.
17. Enter 1 in the **Enter store number** field and then click **Submit**.

   **Note:** You may not need to change the store number because 1 is the default value.

   1010data displays all of the transactions for every store except store 1.

Since your Quick Query is so useful, add it to your list of favorites on the **Start Page**.

18. Go back to the **Folders and Tables** browser.

19. Select the **Transactions by Store(s)** Quick Query by single-clicking it.
1010data highlights the Quick Query in blue and displays the full path below the **Folders and Tables** toolbar. In addition, a list of actions you can perform are displayed.

20. In the list of actions below the **Folders and Tables** toolbar, click **Add Favorite**.

1010data adds your Quick Query to the **Favorites** section on the **Start Page**.

![Recent Worksheets and Favorites](image)

**Note:** To remove a favorite, click the **Remove Favorite** (●) icon next to the item you want removed.

Now, all you have to do is click your Quick Query on the **Start Page** to run it.

Now that you know how to create and work with a Quick Query, you might want to share your Quick Query with other users or user groups. Learn how to do this by reviewing **Share a Quick Query** on page 79.

### Share a Quick Query

1010data allows you to share your Quick Queries, as well as the tables and folders that you own, with other users or user groups at your company. When you share a Quick Query, you give permission to others to use it.

To share the Quick Query, you must give permission for the Quick Query and the folder in which it is contained.

In addition to granting users permission for the folder where the Quick Query is located, you must also give users permission to view any tables used by the Quick Query. In this tutorial, a public table available to all users in the group is used, so this is not necessary. In practice, use the **View Info** action below the **Folders and Tables** browser to see all referenced tables for a particular Quick Query.

**Note:** The procedure for sharing a table is nearly identical to that of sharing a Quick Query. The only difference between the two is a table is selected instead of a Quick Query.

In this tutorial you will learn how to move and share the Quick Query you edited in **Edit a Quick Query** on page 72.

To share a Quick Query:

1. In the **Folders and Tables** browser, navigate to your saved **Transactions by Store(s)** Quick Query.

   **Note:** In this tutorial, the location and name of an example user folder is used for illustrative purposes; the name and location of your user folder will be different.
Note: The Owner (Owner) icon directly to the left of the Quick Query title, outlined in red above, indicates that you own the query.

Although you can share the Quick Query from your user folder, this tutorial illustrates how to move the query to a new subfolder before sharing it. This is done to demonstrate some of the inherit permissions features provided in 1010data.

2. In the Folders and Tables browser, click the parent folder containing your Quick Query. This selects the folder into which you want to add a subfolder.

3. On the Folders and Tables toolbar, click the Add Subfolder (Add) icon.

1010data displays the subfolder fields below the toolbar.

4. In the Title field, enter Store Reports. This is the title of the subfolder you are creating.

5. In the Full Path field, enter store_reports.
This is the name of the folder used by 1010data. The name, which is appended to the end of the full path, must begin with a letter and cannot contain any uppercase letters, spaces, or symbols other than underscores (_).

6. Click **Add**.
   The **Store Reports** subfolder is added under your user folder.

7. Click the **Transactions by Store(s)** Quick Query to select it.

8. On the **Folders and Tables** toolbar, click the **Move (→)** icon.

1010data highlights the **Transactions by Store(s)** Quick Query in green and asks where you want to move the item.

9. Click the new **Store Reports** subfolder.
   1010data highlights the **Store Reports** folder in red and displays a confirmation message.

10. In the message dialog, click **OK**.
    1010data moves the Quick Query from the parent folder to the **Store Reports** folder.
Next, you will assign two users in your organization permission to use your query.

**Note:** In this tutorial, the names of our two example users, jane_doe and john_smith, are used for illustrative purposes. The names you specify must be existing 1010data users in your organization.

The first part of this task is to give the two users access to the **Store Reports** folder where the Quick Query is located. This is important because other users must have access to the folder where your Quick Query is saved or they will not be able to see your query.

11. Click the **Store Reports** folder to select it.
   1010data highlights the folder and its contents in blue.

12. In the list of actions below the **Folders and Tables** toolbar, click **Edit Info**.
   1010data displays detailed information about the selected folder, which you can edit.
13. In the Users field, add the names of two existing 1010data users within your organization.

   Note: Separate multiple users in the field with a single space.

If you wanted to share the Store Reports folder, and all of its contents, with all users who have been granted permission to its parent folder (in this tutorial, the Examples folder), you would select the Inherit Users checkbox. However, because you want only the additional users you just entered to have access to the Quick Query, do not select the checkbox.

   Note: The Inherit Users checkbox takes precedence over the Users list. The user names listed in Users are ignored when the Inherit Users checkbox is selected.

14. Click Save changes.

   1010data saves your changes and displays a confirmation message.

Now, you need to add permissions for the Quick Query itself.

15. Click the Transactions by Store(s) Quick Query to select it.

   1010data highlights the query in blue.
16. In the list of actions below the Folders and Tables toolbar, click Edit Info. 1010data displays detailed information about the selected Quick Query, which you can edit.

With respect to sharing, the fields you are interested in are Inherit Users and Users. By default, only the name of the user who created the query is listed in the Users field. You can add additional users, separated by a single space, who can run this particular Quick Query. However, since you already granted two users in your organization permission to the Store Reports parent folder, you can simply select the Inherit Users checkbox instead. This checkbox will share the Quick Query with all users who have been granted permission to the Store Reports folder.

**Note:** Inherit Users takes precedence over the Users list. The user names listed in Users are ignored when the Inherit Users checkbox is selected.

17. Select the Inherit Users checkbox.

Although it is not necessary for sharing Quick Queries, you may want to change the name of the Quick Query to something more intuitive. By default, 1010data automatically appends to the end of a query name
a combination of a number and the owner's user name. For example, the name of the Quick Query in this tutorial ends in t608870601_tc_cmiller.

18. Enter trans_by_stores in the Name field.
   The name must begin with a letter and cannot contain any uppercase letters, spaces, or symbols other than underscores (_).

19. Click Save changes.
   1010data saves your changes and displays a confirmation message.
   The two users you added to the Store Reports folder can now run your Transactions by Store(s) Quick Query.

   Note: After the permissions of a folder or Quick Query are changed, any impacted users must log out and log back in before the new permissions take effect.
1010data provides a way for you to generate high-quality charts from your data.

It can sometimes be easier to find trends and see differences more easily in a chart. For example, it may be quicker and easier to find the day of sales with the highest profit margin from a chart than from a table of numbers listing the same information. Charting can help you make sense of large amounts of data that might otherwise be too overwhelming to comprehend.

The tutorials in this section demonstrate how to create two kinds of charts. The first chart you will create is a bar chart that shows total sales and profits for all stores combined for the fiscal month of May. The second chart you will create is a pie chart that shows the profit for each store in the fiscal month of May. In addition, you will learn how to edit and export a chart.

For more information about charting, see Charting in the 1010data User’s Guide.

Create a bar chart

You can create a bar chart to show comparisons among categories in your data.

The first step to creating a chart in 1010data is to prepare your data. For this tutorial, this step has already been done so you can focus on creating the chart itself. The sample data provided compares the total sales, cost, and profit for stores in a fictitious retail chain. Use this data to create a bar chart comparing the total profit, sales, and cost of all stores combined for each day in the fiscal month of May. Once you have created your chart, you will save it for use in a later tutorial.

To create a bar chart:

1. Open the Bar Chart Sample Data Quick Query (pub.doc.retail.barchartex).
   1010data displays the Profit, Sales, & Cost by Date tabulation.

   ![Example of Profit, Sales, & Cost by Date tabulation]

2. Click Chart > Bar.
   1010data displays the Chart Builder in the Create Chart window.
3. Create a bar chart showing the total sales and profit by day.
   a) From the Data Columns panel, drag Date into the Data (Labels) section of the Chart Parameters panel.
   b) From the Data Columns panel, drag Sales and Profit into the Data (Bars) section of the Chart Parameters panel.
   c) Click Update.
   1010data displays a bar chart of your data.
1010data provides a number of customizable settings that control the way a chart is displayed, including the size of the chart, background color, appearance of the title and the axes, and placement of the legend. You can also add titles and labels.

4. Add a title to your chart.
   a) Click the **Toggle right settings panel** ( ) icon. The **Customization Panel** appears.

   ![Customization Panel](image)

   b) In the **Customization Panel**, click **Title**. The **Title** customization settings appear.

   ![Title settings](image)

   c) In the **Title text** field, enter **Sales & Profit by Date**.

   d) Press Enter.
1010data adds the title to your chart.

5. Add a text label to the y-axis.
   a) In the **Customization Panel**, click **Axes**. The **Axes** customization settings appear.

   ![Customization Panel](image)

   b) At the top of the **Axes** section, click the **Y-axis** tab.
c) In the **Y-label** field, enter **Dollars**.

d) Press **Enter**.

1010data adds the new text label to the y-axis your chart.

Once your chart is created, you can save it so you can access and update it at a later date. To save your chart, save the worksheet as a Quick Query and select the option to save open charts.

**Note:** This tutorial only demonstrates how to save a chart by using the **Save as Quick Query** menu item. It does not explain the full functionality of a Quick Query. For more information, see *Quick Queries* on page 65.

6. Save your worksheet and chart as a Quick Query.
   a) On the **File** menu, click **Save as Quick Query**.

   1010data displays the **Save As a Quick Query** dialog.
b) In the Title of Query field, enter Sales and Profit by Date.

c) Select the Save open charts checkbox.

d) Click Submit.

1010data saves the Quick Query in the My Data folder.

e) Close the Save As a Quick Query dialog.

7. Close the Sales Item Detail tab.

The Sales Item Detail tab is located at the bottom of the screen.

1010data closes the Sales Item Detail tab.

In this tutorial, you created a simple bar chart from your data and saved it as a Quick Query for future use. While the data for this tutorial was small and easy to understand, the data you work with each day will undoubtedly be much more complex. Using the charting options provided in 1010data can help you gain insight to your data in ways that would be quite difficult to see otherwise.
Create a pie chart

You can create a pie chart to show the proportional relationship of segments in your data to the whole.

You might want to know how individual stores contributed to the overall profit of your chain. For this tutorial, you can use a sample Quick Query that calculates these metrics. Use the data from this Quick Query to create a pie chart that shows this information. Once you have created your chart, you will save it for use in a later tutorial.

To create a pie chart:

1. Open the **Pie Chart Sample Data** Quick Query (`pub.doc.retail.piechartex`).
   1010data displays the **Profit by Store** tabulation.

You can create a pie chart of this information to visually show how much each store contributed to the total profit.

2. Click **Chart > Pie**.
   1010data displays the Chart Builder in the **Create Chart** window.

3. Create a pie chart showing the percent of profit each store contributed to the chain.
   a) From the **Data Columns** panel, drag the **Store** column into the **Data (Labels)** section in the **Chart Parameters** panel.
   b) From the **Data Columns** panel, drag the % of **Total Profit** column into the **Data (Sectors)** section in the **Chart Parameters** panel.
   c) Click **Update**.
   1010data displays a pie chart of your data.
4. Add a title to your chart.
   a) Click the **Toggle right settings panel** ((icon.
   b) In the **Customization Panel**, click **Title**.
   c) In the **Title text** field, enter **Profit Contribution by Store: May 2012**.
   d) Press **Enter**.
   1010data adds the title to your chart.

5. Save your worksheet and chart as a Quick Query.
   a) On the **File** menu, click **Save as Quick Query**.
1010data displays the **Save As a Quick Query** dialog.

b) In the **Title of Query** field, enter *Profit Contribution by Store*.

c) Select the **Save open charts** checkbox.

d) Click **Submit**.

1010data saves the Quick Query in the **My Data** folder.

e) Close the **Save As a Quick Query** dialog.

6. Close the **Sales Item Detail** tab.

1010data closes the **Sales Item Detail** tab.

In this tutorial, you created a pie chart from your data to visually see the percent of total profit each store contributed to the retail chain for the fiscal month of May. In chart form, it is easy to see that stores 1 and 3 are contributing quite a bit more to the bottom line.

### Edit a chart

The Chart Builder allows you to modify existing charts that you have saved.

In this tutorial, you will modify the bar chart you created and saved in *Create a bar chart* on page 86. You will add more data to the chart and then change display preferences like colors and labels.

To take this tutorial, you must have completed *Create a bar chart* on page 86.

To edit a chart:

1. In the **Folders and Tables** browser, double-click the **Sales and Profit by Date** Quick Query.

   Your Quick Query is located in the **My Data** folder.

1010data displays your bar chart in the Chart Builder in the **Create Chart** window.
As you can see, your chart looks exactly as it did before you closed it. Now, you can edit the chart. Add the Cost column to the chart so you can see how the cost of items sold relates the profit of the item.

2. Add the Cost column to your chart.
   a) From the Data Columns panel, drag the Cost column into the Data (Bars) section above the Sales column.

      Note: The order that columns are arranged in the Data (Bars) section determines the order that the columns are displayed in the chart.

   b) Click Update.

      1010data updates your chart.
Now that more data is in your chart, the title does not make quite as much sense. Update the chart title to account for the additional information.

3. Update the chart title.
   
a) Click the **Right Settings Panel (⎅)** button.
   
b) From the **Title** customization section, update the **Title** text field to **Cost, Sales, & Profit by Date**.
   
c) Press **Enter**.
   
1010data updates the chart title.

![Cost, Sales, & Profit by Date](image)

You can change the colors of the bars in the chart to suit your tastes. In the example above, it might make more sense to change **Cost** to red and **Sales** to blue.

4. Change the color of the bars in your chart.
   
a) In the **Customization Panel**, click **Data Series**.
   
1010data displays the **Data Series** customization settings.
b) Next to the **Colors** field, click **Add**.  
1010data displays a blank field below the **Colors** field.

c) Click the newly added blank field.  
1010data displays the color palette.
d) In the Theme Colors section, click the red box ( ) in the top row. 1010data enters the hexadecimal code for the selected red color in the Colors field and changes all of the bars in the table to that color.

Note: Since there is only one color entered in the Colors field, all of the bars are set to the selected red color. To change the bar color for the remaining two columns, repeat the process two more times. Each added color changes the bar color of the next column in the chart.

e) Next to the Colors field, click Add, then click the field that appears, and finally, click the blue box ( ) in the top row. 1010data adds the hexadecimal code for the selected blue color in the Colors field and changes the Sales bars to blue.

f) Next to the Colors field, click Add, then click the field that appears, and finally, click the green box ( ) in the top row. 1010data adds the hexadecimal code for the selected green color in the Colors field and changes the Profit bars to green.
In this tutorial, you learned how to edit a saved chart. Feel free to explore and play with the other customization settings in the Chart Builder. This will help you learn what else is available so that you can fully customize your charts.

Now that your chart is complete, you can save it as a PDF. This is helpful if you need to share the information with others who do not have access to 1010data. For instructions, see Export a chart on page 99.

Export a chart

You can export a chart from 1010data and save it to your computer as a PDF file.

A chart created in 1010data can be exported as a PDF file for a variety of uses. For example, you can share the chart with someone who does not have access to 1010data, or you could use the chart as an image within a report or presentation. This tutorial explains how to open your previously saved pie chart and export it as a PDF file.

Note: Although this tutorial uses a previously saved chart, a chart does not need to be saved before it can be exported.

To take this tutorial, you must have completed Create a pie chart on page 92.

To export a chart:

1. In the Folders and Tables browser, double-click the Profit Contribution by Store Quick Query.
   
   Your Quick Query is located in the My Data folder.

   1010data displays your pie chart in the Chart Builder in the Create Chart window.
2. From the menu bar of the Chart Builder, click **Export**.

1010data saves the chart to your computer as **download.pdf**.

**Note:** Depending on the browser you are using, you may be prompted to open or save the PDF file. If you are prompted, save the file.
Index

P
permission 79

S
share 79
sharing 79